Biological Sequence Analysis Spring 2009 Dr. Richard Friedman
(212)851-4765 friedman@cancercenter.columbia.edu 824 ICRC

Lesson 13: Functional Genomics II: Functional Genomics Databases and
Overrepresentation Analysis and Clustering of Microarray Data

In this class we are going to learn the basics of using web-accessible function and pathway
databases, and how to find the functions and pathways associated with a set of differentially
expressed genes.

Theory

1. Pevsner on functional databases:
A. OMIM p. 659-661.
B. GO 243-246.
C. KEGG 258-263.

2. Ontools. Read sections on Onto-Express and Pathway-Express.

http://vortex.cs.wayne.edu/projects.htm

3. Pevsner on clustering or microarray data: p. 203-214.

Theory of Hierarchical Clustering (Unsupervised Learning)

d,,= distance in expression patterns between genes x and y.
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r,,= modified Pearson correlation between expression of genes x and y with zero mean.
N= Number of samples.

Then a tree is inferred based on distances.

Summary of Commands:
Note: In this document different fonts have different meanings:

Times is used to explain commands.



Courier is used to indicate commands and command options.

Courier italics are used to indicate command parameters,

for example, filenames.

Courier bold is used to indicate commands that are not

displayed.

Courier bold italics are used to indicate computer-generated

output.

Helvetica is used to indicate menu items.

http://www.ncbi.nlm.nih.gov/entrez
Gene

OMIM

OMIA

http://www.geneontology.org/

Accesses the NCBI ENTREZ web page
Diverse information on genes including
molecular interactions.

Descriptive genotype-phenotype
relationships in humans.

Descriptive genotype-phenotype
relationships in organisms other than
humans.

Gene Ontology Gives Biological Process,
Molecular function, Cellular Component for
proteins/

Gene symbol/name, exact match To search for a gene/protein

Terms

http://bond.unleashedinformatics.com/Action?
BOND: Biomolecular Object Network Database.

Search bind using a field specific query

This will give you all of the terms associated
with a protein.

To search for a term. Following the

links associated with a term will give

you a definition of the term and the names
of all of the proteins associated with that
term.

A database that gives interaction
partners between biological molecules.
Enables user to specify the kind of search.

Field: Interaction description contains at least one of the following words

On the list page clicking on an:
interaction identifier

Generates a list of interactions in which a
specified molecule plays a role.

gives a description of the interaction in
question.



On the interaction page, clicking on:
expand all

http://www.genome.jp/keqgqg/

Click on KEGG Table of Contents
KEGG PATHWAY
KEGG GENES

SEARCH
KEGG for subject
GENES for genename
PATHWAYS for pathway

SEARCH organismcode for genename
Organism
GENES for Genename
PATHWAYS for Pathway

Analysis with Onto-tools

A. Preprocessing for ontools:

gives a more detailed picture of the
interaction in question.

KEGG: Kyoto Enyclopedia of Genes and
Genomes.

Encyclopedia of Pathways.
Encyclopedia of Genes.

Searches Gene database for name of gene.
Searches Gene database for name of gene.
Searches Pathway database for name of
pathway.

Searches for name of gene in specific
organism.

Searches for organism code.

Searches Gene database for name of gene.
Searches Pathway database for name of
pathway.

1. Move output files to a directory that you can work in.
2. Open output files with Microsoft Excel. Autoformat column length and save file

as Excel Workbook with new name.

3. Copy all genes with B >0 to new Excel Workbook and save as Workbook with

néw name.

4. Delete all columns but the Affymetrix probeset identifier. Delete the header row.

save as text file.

B. Analysis with Onto-Express and Pathway-Express.
http://vortex.cs.wayne.edu/ontoexpress/ Onto-Express web-site.

Login:
Onto-express

Login to web-site.
Select Onto-Express for finding

overrepresented Gene Ontology Categories.

Fill out the ontoexpress input window as below (settings for experiment- the parameters will of
course vary with other files, organisms, and chip).



& save Resulis Q@@

Save Directory: :uments\sequencecourse\lessom3|‘ Browse ‘

Save:
[v] Biological Process [v] Cellular Component

[v] Chromosome Location [v] Molecular Function

[C] Save Details [ Print Headers
[] accession Number [] Locus ID
[ Cluster ID [] official Gene Symbol

[[] Save Tree View

| save || cance

Onto-express output files:
bioprocess

molecular
cellular
chromosome

To process output files with Excel:
Open
Files as type textfiles
Delimited
Tab
Semi-colon
Format->Column->Autofit

Overrepresented biological process
categories.

Overrepresented molecular function
categories.

Overrepresented cellular location
categories.

Assignment of genes to chromosomes.

Opens file from inside Excel.

Lists text files in the menu.

Reads file as entried separated by delimiters.
Recognizes tabs as delimiters.

Recognizes semi-colons as delimiters.

Fits selected columns.



Data->Sort Sorts by the selected column.

Expand Selection Sorts rest of row according to the selected
column.
File->Save As Save as file with name typed in box.

Save As type Microsoft Excel Workbook
Save as file in Excel Format.
1. Open each of these files with Excel (check delimited and tab and semicolon).Autofit

selection for column, sort by corrected p-value, and save as a Workbook.
& save Results Q@@

Save Directony: :umentslsequencecourse\lessum3" Browse ‘

Save:
[v] Biological Process [v] Cellular Component

[v] Chromosome Location [v] Molecular Function

[v] Save Details [V] Print Headers
[v] Accession Number [v] Locus ID
[V] Cluster ID [v] Official Gene Symbol

[v] Save Tree View

| sae | | cancel

The above box will output the same 4 files as before only with the genes included.

In addition, it will output, “treeview”, a file with all of the gene ontology categories detected and
“treeview_input”, a file with all of the gene-ontology categories detected along with input genes
from the list. The above files cannot be sorted.by corrected p-values without getting mixed up,
because there is more than one row per Gene Ontology category.

Pathway-Express Select Pathway-Express for finding
overrepresented KEGG pathwayCategories.
Use list of pathways with log fold changes
for input.



& PathwayExpress - Input

EExE

Run a demo dataset
‘ Select a demo dataset v | ‘ Demao Info |
Run Demo
Analyze your own dataset
Input File : llencecoursellessom a Up-vbgt&bd” Input File I

Reference File : |

| Refe.File |

Reference Array: | affymetrix human genome u95av2 array

M

Organism: | Homo sapiens v

Input Type : () Gene Symbol ) LocusLink
) Accession {® Probe Id
Submit Exit
Advanced options
’ Advanced options I

Advanced options
Corrections = fdr

Pathway express output-windows and options
Bar Graph
Pathway Details

(Right mouse button over pathway link)

Show Pathway Genes
Show Pathway Details

Save Table

Pathway Gene Details

(Right mouse button over genelink)

Input Details

Corrects pathways for false discoveries with
false discovery rate.

Display of overrepresented pathways..
Shows list of pathways in tables.

Lists pathway options.

Changes pathway in Pathway Gene Details.
Shows KEGG diagram of pathways with
genes on list indicated.

Saves Pathway Details file.

Shows list of genes in selected pathway and
indicates whether or not they are part of the
input list.

Lists gene options options, which are
analogous to Pathway Details options.

Shows list of genes in input lists and
indicates whether or not they are part of a
pathway. Mouse options analogous to other
windows.



Hierarchical clustering with Cluster 3.0 and JavaTreeview.

1. Start R and go to the estrogen working directory.

Fle Edt View Misc Packages Windows Help

iR Console

R version 2.6.1 (2007-11-26)
Copyright (C) 2007 The R for 1 r
ISEN 3-900051-07-0

R adhindddied Choose directory
You are velcome

Type 'license()'

Change working diectory to:
Files\RIR-2.6. 1{ibrary|estrogeniextdata.

R 1s a collaporat]

Type 'contributor]

“eieacion() * on (o]

Type 'demo()' for some demos, 'help()' for on-line help, or

'help.start()' for an HTHL browser interface to help.
Type 'a()' to uit R

Natural languag

fations.

> local ({pkg <- select.list(sort(.packages(all.available = TRUE)))
§ jpmenas pkal) nrecy o, chezacter onlyTRUED)
>

dman. 2Rfor.. - O

Fle Edt View Mic Packages Windows Help Vignettes

R Console
2O Select one

Type 'contributors()' for more information and
‘citation()' on how to cite R or R packages in publi

Type 'demo()' for sowe demos, 'help()' for on-line h

'help.start()' for an HTHL browser interface to help ]
Type 'al)' to quit R. afnyﬂCyRepml
an
rnotate

> local{(pky <- select.list(sort(.packages (all.availf [A0OSE o
+ if {nchar (pkg)) library(pkg, character.only=TRUE))) | [base
> local{(pky <- select.list(sort(.packages(all.avail] [Hicbase E
+ if (nchar (pkg)) library(pkg, character.only=TRUE))) | [festrings

ase

Loading required package: Bioh lass
Loading required package: tools cluster

codetools

Welcome to Bioconductor dalliﬂls
nDoc

yr
Vignettes contain introductory waterial. To view, | lesrogen L
. 0. To cite . see

‘citation("Bichase”)' and for packages 'citation(p{ [sTma

(genefiter

eneplater
Loading required package: affyic Geneno
Loading required package: preprocessCore araphics

> local[(pky <- select.list(sort(.packages(all.availl [oDevices
+ if (nchar (pky)) library(pkg, character.only=TRUE)))




3. In R window:

estrogenEset<-ReadAffy() Loads Estrogen cell files into Expression
object.

estrogenmas5 <-mas5(estrogenEset) Normalizes cel files by the MASS
algorithm.

write.exprs(estrogenmas5, "estrogenmas5.txt")
Saves normalized arrays as text file.

4. Cut and paste file to directory which you are working in for lab.

5. Copy file with differential expression values from last week to file called id_gene.
A, Open it with excel.
B. Delete all columns other than Gene-and-symbol.
C. Sort by ID.
D. Rename Symbol Column “Gene”.
The spreadsheet should look like this:

3 Microsoft Excel

EET Y EETEE TR |

i Fle Edt View Insert Format Tools Data Window StanfordTools Help | ArrayTools

; arial 10 -/ B Z U|E S % s

INEHROSRVE S S0 bl 100
C4 - A

2l idgenes BEX
A N ]
D Gene

100_g_at RABGGTA

1000_at  MAPK3
10017t TIET
1002 at CYP2C19
1003_s_at BLR1
1004_at  BLR1
1005_at  DUSP1
1006_at  MMP10
1007_s_at DDR1
1008_f_at EIF2AK2
1009_at  HINTT
101 st DYRKA

st MAPK11

s_at YWHAE
1012_at  PCAF
1013_at  SMADS
1014_at  POLG
1015_s_at LIMK1
1016_s_at IL13RA2
1017_at  MSHE
1018_at  WNTI0B
1019_g_at WNTI0B
1023 HIPK3
1020_s

| 0| o0 ~| oo a | colmo| -

_at
10221 at IFNATA
10232 EPO
1024t CYP1AT
i« « » »\idgenes /




6. Open Estrogenmas5 within Excel.
A. Make 2 new columns.
B. Paste in the contents of ID gene so that the id column should be aligned
The file should look like this:

3 Microso 5]
EE T |
i Fle Edt View Insert Format Tools Data Window StanfordTools Help | ArrayTools Type a question for help 3|
el 10 2B ZU|ESEHES % o RN FEE| - A
SHRSIRPEI S LB K9 o8 R 2@
F9 - fx 457493919912782
s B —
1 A B [ D E F G H | J K L M N -
1 D Gene 110-1.c high10-2.c highd8-1.c high48-2.c low10-1.ce low10-2.ce lowds-1.ce lowd8-2.cel =
2 |100_g_at 100_g_at RABGGTA 5318 B46.7652 B893.6746 963.3054 B884.1852 1211.845 725.1446 1098.112
3 |1000_at 1000_at MAPK3 2072193 2120803 2302185 2398957 3187.346 2724.568 2425639 2422969
4 |1001_at 1001_at TIE1 1589701 532984 2250213 1328748 3970776 18.18771 1559373 105.1721
5 |1002_f at 1002_f at CYP2C19 13.83366 20.47484 32.83082 90.04274 2205818 3921241 31.06428 41.11254
6 |1003_s_at 1003_s_at BLR1 185.6003 1938242 160.4024 2740375 57.99479 60.84516 4755877 290.0226
7 |1004_at 1004_at BLR1 169.8508 161.2442 1957502 2585439 152578 163.5449 252.4008 153.0538
1 8 [1005_at 1005_at DUSP1 313.7365 4059544 2241689 3139899 705.0029 766.2848 B893.1601 1559.65
1 9 [1006_at 1006_at MMP10 2048994 2262188 4.574939) 16.25683 2120307 4.188329 11.79341 38.97637
1 10 [1007_s_at 1007_s_at DDR1 5261.891 B496.665 5145718 5207.922 8383247 7866.76 7706.648 6125.094
1 11[1008_f_at 1008_f at EIF2AK2 4198.788 9226769 3042358 5653327 1634603 5124613 4401.711 6235.49
1 12 |1009_at  1003_at  HINT1 4598.059 4052111 6772822 4628.413 2966.023 2789746 2196.602 1670.843
1 13 |101_at 101 _at DYRK4 17.22251 1534156 24.00909 17.15284 23.24743 15.41839 19.59627 23.04363
1 14 |1010_at  1010_at MAPKI11 1746486 61.21554 2076101 44.85587 1738519 3968644 88.85223 76.91898
1 15 |1011_s_at 1011_s_at YWHAE 0071976 767.2434 2211709 1484353 7328722 8564684 1032.797 721.4463
1 16 [1012_at 1012_at PCAF 7072225 62.1532 2292618 9196284 834887 77.49091 40.00592 118.0775
1 7 [1013_at  1013_at SMADS 1137053 116.7283 4862628 39.85557 114.7546 79.01453 47.96287 6.717195
B 3 [1014_at  1014_at  POLG 1084.494 7657347 1548439 1162647 108062 1143464 1312972 1234.014
B J [1015_s_at 1015_s_at LIMK1 46.45188 24.98275 13 6 131.872 52.44243 146.2038 231.3765 350.6037
) |1016_s_at 1016_s_at IL13RA2 | 52.10842 33.36456 432515 667575 1358892 4667975 20.00002 110.7657
| 1017_at 1017 _at MSHE 9396083 817148 126.1752 8670582 89.14314 8827552 182.2691 120.9935
2 2 1018_at  1018_at WNT10B  87.93711 76.41729 57.79347 2509544 6185392 8898151 5178122 1225474
1019_g_at 1019_g_at WNT10B  217.5104 230.4868 367.7689 514.2963 243.2797 267.2168 393.8499 290.5965
X $1102_at  102_at  HIPK3 3899282 39.24108 5202848 167.2717 6105234  56.144 1330828 67.93559
> |1020_s_at 1020_s_at CIB1 2184607 2755.012 212054 1702.346 3209.82 3336.758 2896.835 2499.176
511021 _: 1021_at  IFNG 39.1303 2557162 62.59795 1356775 B87.51481 46.20445 B84.75281 124.9427
B 7 11022 f at 1022 f at IFNAT4 3317248 5270055 5.195407 1050966 4518682 2155817 2365856 7.845053
| 281023 at 1023 at EPO 37.10382 36.06208 4079993 49.4669 2378648 20.15079 30.35107 54.32572 e
1024_at 1024_at CYP1A1 177.3468 2933183 5452868 174.4687 584.066 698.7656 671.8123 569.0533 ~
w 5} di ] g

7. Delete the 2 id columns so that the spreadsheet looks like this:

3 Microsoft Excel
¢ R YT |
! Fle Edt View Insert Format Tools Data Window Stanford Tools Help | ArayTools Type a question for help
£ Arial -0 -|B Z U] B8 % o WB|FEE| DA
GRS E % DR S0 8 T e -
D2 - /& B893.674581461621

£l estrogenmas’

RABGGTA 712.5318 646.7652[ 893 6746) 963.3054 BB4.1852 1211.845 725.1446 1098.112
2072193 2120.803] 2302.185| 2398.957 3187.346 2724.568 2425639 2422989

15.89701 53.2984| 2250213 1328748 39.70776 18.18771 155.9373 105.1721

1383366 20.47484| 32.83062 90.04274 2205818 39.21241 31.06428 41.11254

1856003 193.8242] 160.4024 274.0375 57.99479 B0.B4516 47.55877 290.0226

169.8508 161.2442| 1957502 2585439 152578 163.5449 252.4008 1530538

9.65
20.48994 22.62188| 4574939 1625683 21.20307 4.188329 11.79341 38.97637
5261.891 B496.665] 5145718 5207922 §383.247 786676 7706.648 6125094
4198.788 9226769| 3042358 5653.327 1634.609 5124513 4401711 6235.49
4598.059 4052111} 6772822 4628.419 2966.029 2789.746 2196.602 1670.843
17.22251 15.34156] 24.00909 17.15284 23.24743 15.41839 19.59627 23.04363
17 46486 61.21554] 2076101 44.85567 17.36519 39.68644 88.85223 76.91898
907.1976 767.2434| 2211.709 1484.353 7328722 B856.4684 1032.797 721.4483
7072225 62.1532) 2292618 9196284 83.4887 77.49091 40.00592 118.0775
1137053 116.7283) 4862628 39.85557 114.7546 79.01453 47.96287 6717195
1084.494 76573471 1548439 1162647 108062 1143.464 1312972 1234014
145.45188 24.98275) 130.6936 131.672 5244243 146.2038 231.3765 350.6037
5210842 33.36456| 432515 B6.7575 1358892 4667975 20.00002 110.7657
9396083 81.7148] 1261752 8670562 £9.14314 88.27552 182.2691 120.9935
B87.93711 76.41729] 57.79347 2509544 6185392 88.98151 5178122 1225474
217.5104 230.4868| 367.7689 514.2963 243.2797 287.2168 393.8499 2905965
33.99282 39.24108| 5202848 167.2717 B1.05234  55.144 133.0828 67.93559
2184607 2755.012) 212054 1702346 3209.82 3336.758 2896.835 2499.176
391303 2557162] 6259795 1356775 6751481 46.20445 8475281 124.9427
3317248 52.70055] 5195407 105.0966 4518682 2155817 2365856 7.845053
8| 37.10382 36.06208] 40.79993 49.4669 23.78648 20.15079 30.35107 54.32572
CYP1A1  177.3468 293.3188| 54.52868 174.4687 584.066 698.7656 671.8123 569.0533

<

<> vi\estrogenmas5 /—‘— |

A B C D E F G H I
Gene high10-1.c high10-2.c| h'?hﬂi c highd8-2.c low10-1.ce low10-2 ce lowd8-1.ce low4S-2.cel

[ Breat. [Bavat. I3 Fir.. | "z friedm... ~ RGui v BoMc. - /B <o Rfe S41PM

8. Save file as text file.called “estrogenmas5gene”



9. Open Cluster 3.0 on the PC and load mas5gene

R

Edt View Misc Packages Windows Help Vignettes

Gene Cluster 3.0
File Help

(5] rsellesson1 dkclustericluster2 =3

Type a question for help

File loaded [C:\Documents and Setings\Richard\Hy

neti

e mﬁgsmu —

Job name. [estrogenmas_gene
Ol s "

. Data set has B (ko L 10ffice Online

- 8 Columns

N * Connect to Microsoft Office

- Fiter Data | Adiust Data | Hierarchical | k-Means | SOMs | PCA | a Lo

- >l = Get the latest news about using
Wword

Filter Genes N

. Automatically update this st
- from the web.
. More. .

I~ %Present>= [ e
I~ SD (GeneVecto) [ 20
I~ Atleast | 1 observationswihabsival>=| 20
I~ Maval-Minval>= [ 20

Apply Fiter

Aocep! Fiter

“wonmi

iy start @ TeraT.. "5 friedm... - RGU 4 c

10. Click adjust data. Check
A. Log Transform
B. Center Genes
C. Center Arrays

< R
Fille Edt View Misc Packages Windows Help Vignettes

m [] rse\lesson13\cluster\cluster2

CADocuments and Setings\Fichard\Wly

e tst

Job name

estrogenmas_gene.

Cln e .
Data sethas ;2‘25 Gl _11.0ffice Online

Columns

) * Connect to Microsoft Office
- Fiter Data Adjust Data | Hisrarchical | k-Means | SOMs | PCA | oG oo
~ & * Get the latest news about using
A — werd
b * Automatically update this list
N from the web
IV Log transform data -,.....u.. More.
- | searchfor:
. ¥ Cent ¥ Cent —— v
. oee o e + || Example: "Print more than one copy’
N & Mean & Mean 5
: © Median © Median . JCeen
- I BB

(Ovder of Operations:

Log Transfom
(Center Genes
Nomalize Genes

Center Arraps
Notmaize Arays |

Done loading data

J3Fir.. v T friedm.. RGUI 5:46 PM

‘5 start 3w, -| @Teral..

D. Click Apply

Click filter data

10



11. In filter data Check
A. SD (Gene Vector ) 2.0
B. At least one observation with abs(val) >= 2.0
C. MaxVal-MinVal>=2.0

Gene Cluster 3.0
File Help

File Edi

ellesson13\cluster\cluster2

Fileloaded [C\Documents and Sellings\Fichard'y
+ if (ne et les\RIR-2. 6. 1\librarylestrogen
Loading Favor Tools  Help
Loading ~ —
- = b
[ [ O search [ roiders
Jobname [estiogenmas_gene
ram Files\RIR-2.6. 1\librarylestrogen
Vigne:
‘openy | Datasethas 1262 rows S| T
teita 8 Columns. [Tasks File Folder
ko File Folder
Loading| FiterData | Adjust Data| Hierarchical | kMeans | SOMs | PCa | = File Folder
Loading i File Folder
> local - Fier er File Folder
+ if (nc] Ider to the File Folder
> estro File Folder
> estro
™ %Present>= 80 =7 File Folder
backgro er's Fles File Folder
PU/HM = Fil Folder
express W 5D (Gene Vectal) 20 .
P e
¥ Atleast [ 1 observalions with abslVal) >= 20 K8 Fie
2KB  File

V' Maival -MinVal >= 20
Apply Fiter

Accept Filer

Done adusting data

i start 3w - @ Teral.. 3 - [75 friedm.. RGu ] 5:52PM

D. Click Apply filter. The GUI should say “70 passed out of 126257

File Edit EIE er 3.0
File Help
0 =]
R Co File loaded C:\Documents and Settings\Richard\My ,'.
 ge
0 ne.tst =
Type a question for help [+ X

g | [ dobrame [sogenms_gene Ty S et = B
- | i 12625 Rows ﬁaﬁ
- 8 Columns Uq

1.0ffice Online

N Fiter Data | Adjust Data | Hierarchical | k-Means | S0Ms | PCA |

= Connect to Microsoft Office.
~Filter

* Get the latest news about using
word

Automatically update this list
from the wel

]

I~ %Present>= [ e
¥ SD(GeneVesto) | 20
¥ Btleast [ 1 observations withabstvall>= | 20
¥ Mawal-Mival>= [ 20

70 passed out of 12625

Accept Fiter

More.

—a—a_a

Done Analyzing Filters

+4 start 3w, | @Teal.

I3Fir.. v Tz friedm... - RGU 2§ clus

S || T KLy ssiem

E. Click Accept filter

11



12, Click on Hierarchical tab. Check
A. Cluster Genes.
B. Cluster Arrays

Gene Cluster 3.0

File Edit
EEE

R 0o | | Fileloaded

C:\Documents and Settings\Richard\My

ne.tit

Job name: [estrogenmas_gene &

" g
= L. A
! . Eusrﬁsmted v x|
Data set has 70 Rows

8 Cobmns O )
A Gffice Online

* Connect to Microsoft Office
Online:

Fiter Data | Adust Data Hierarchical | k:Means | SOMs | PCA |

N Get the latest news about using
: word
N [V Cluster ¥ Cluster * Automatically update this st
M he web
- 1 Calculate Calculate More.
: T eights T eights Soorch for:
- Simiaity Metic Simiiy Metic -
: [Conelation (uncentered)  ~] |Conelation (uncentered)  ~] || Example: "Print more than one copy”
': Open
@i ] %I
Certioidnkage | Singlelinkage | Complete linkage | Average inkage

Done Analyzing Fiters

Then click “Average linkage”

Files entitled:
A. estrogenmas_gene.atr (ATR)
B. estrogenmas_gene. (CDT)
C. estrogenmas_gene. (ATR)

Should appear in your directory. You should now be ready to display the cluster diagram and
heatmap.

12



13. Java Treeview
A. Open Java Treeview.
B. Select Open-> File
C. Scroll to directory containing CDT file
D. Open CDT file

< RGui
File Edt View Misc Packages Windows Help Vignettes
\Documents and Settings\Richar d\My Documents\sequencecourse\lesson13\cluster\cluster2

Edt Vew Favortes Toos Hep
Qock - © - [F Psewrh [ Folders [~

address [ C:ipocument

- R Console

T cluster-cluster
i Fle Edt View
i A4 Normal

File and Folder Tasks

() Make a new folder File Sefiings Analysis Export Window Help

) Publish this folder to the.
web Hello How are you Gentlepeople
Welcome to Java TreeView

lad share this folder

Other Places

Open X
T - @8 e EE

[} estrogenmas_gene.cdt Options
swe

Parse quoted strings

Details

B CIER-RY
Page 10 Sec 1

File Name:

Files of Type: [CDT or PCL Files

Type a question for help

af File Setings Analysis Export Window Help
Dendrogram

ew Status
[l 8 | No status ino for

Usage Hints
Click and drag to scroll Started

I»

]

o

[« D[«

[»

Gffice Online

Jronnect to Microsoft Office
priine

Dr]llo]

fset the latest news about using
ord

update this st

SR T RO 1sean

3 ~ [ TeraTer. % K - RGUI ava Tre...
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15. You can select and magnify clusters by clicking on nodes:

RGI
Fle Edt View Misc Packages jows Help _Vignettes

Java TreeView : C:\Documents and Settings\Richard\My DocumentsisequencecourseMessont 3\clustericlu... [= (B[]
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Lab

1. Characterize the function, interactions and pathways of the c-src (or the protein of your
choice) using web-accessible databases. Save the necessary information.

2. What is the phenotype associated with the BRCA1 185DELAG mutation in humans?

3. From the list of differentially expressed genes obtained in the 10 hour estrogen experiment
explained in part I, generate the following lists in Excel Workbook format:

A. The Biological Function Gene-ontology values overrepresented in the
Estrogen experiment sorted by corrected p-values.
B. The Biological Function Gene-ontology values overrepresented in the
Estrogen experiment with gene symbols and other identifiers (unsorted).
C. The KEGG pathways overrepresented in the Estrogen experiment.
4. Produce a heatmap representing the gene expression patterns of the estrogen dataset from the
last lab clustered by both gene and array.

Copyright 2002-2008 by Richard Friedman. The information on this site is protected by United
States and international copyright laws. All rights reserved.

[You may printout portions of the text and images for your own personal, noncommercial use.
You may link to this site from another website. You may not print, reproduce, upload, post,
transmit, download or distribute any materials without written consent except as stated above.
You may not modify any material residing on the site. You may not use the materials in any
manner that infringes on the rights of another party.]

15



